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前言

在现代电力电子技术中，电力变换有下列几种，AC-DC（即 AC 转换成为

DC，其中 AC 表示交流电，DC 表示直流电）称为整流，DC-AC 称为逆变，AC-AC

称为交流-交流变换，DC-DC 称为直流-直流变换。高频半导体功率器件出现后，

用半导体功率器件作为高速开关，使其在开关状态下工作，实现能量转换的电路，

称为开关变换器电路。利用闭环反馈控制稳定变换器的输出，再加上保护环节等，

即可构成开关电源（Switching Power Supply）。开关电源主要组成部分是 DC-DC

变换器，它是功率转换的核心。

DC-DC 变换器的功能是将直流电变为另一固定电压或者可调电压的直流电，

包括直接直流变流电路和间接直流变流电路。直接直流变流电路也称为斩波电路，

输入输出之间不隔离。间接直流变流电路是在变流电路中增加了交流环节，在交

流环节中通常采用变压器实现输入输出之间的隔离，因此也称为带隔离的直流-

直流电路。第一种电路常见的结构有 boost 电路、buck 电路、cuk 电路等等。第

二种电路常见的电路结构有正激电路和反激电路。

本课程设计的主要内容是为单端正激电源和单端反激电源的设计和制作。包

括电源的原理图设计，其中涉及到电路结构设计和电路元器件参数设计；电路的

电气仿真，其中涉及到利用 EDA 设计工具 Multisim 仿真软件进行功能实现和电

路参数优化计算；电源 PCB 板的制作，其中涉及到利用 PCB 板制作软件 Altium 

Designer 软件进行电路实物板的制作。

本课程设计的目的，在于使学生将在课堂上学到的电力电子知识同实际结合

起来，增强对直流功率变换电路工作原理的直观认识；增强学生自主学习相关电

力电子知识及设计软件的能力和查阅、搜索相关知识的能力；使相关电气、通信

等专业的学生学会利用相关 EDA 软件如 Multim 和 Altium Designer 等软件进行

电路设计和参数优化，增强动手制作能力。
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第一章 电路工作原理

带隔离的直流-直流变流电路分为单端（single end）和双端(double end )电路

两大类。在单端电路中，变压器中流过的是直流脉动嗲纪念刘，而在双端电路中，

变压器中的电流为正负对称的交流电流。本章主要内容为单端正激(forward)电源

和单端反激(flyback)电源的电路结构，工作原理，应用特点等相关知识的介绍。

1.1 单端正激电路

单端正激电路实际上是在降压式 Buck 变换器中插入隔离变压器而成，当

Buck 电路的开关管 Tr 与续流二极管 D 之间加入变压器隔离器 T1 便可得到。图 1 

-1 给出了正激变换器的主电路拓扑结构。

Tr

D1

D2

D3 C Ro

Vs

Vout

T1

P1

P3

L

n:1

Ip
IL

Io

P2

图 1.1 单端正激变换器主回路电路图

由于正激式变换器的隔离元件 T1 是个典型变压器，因此在变压器副边电路

中必有一个整流二极管 D2 和一个续流二极管 D3，同时也要注意到变压器原边和

副边线圈的同名端有相同的相位。由于是正激工作方式，在两只二极管后要加一

个电感器 L 作为能量的储藏及传递元件。一般电感量大些，使得电流峰值 Ip 较

小。变压器 T1 的并绕一个绕组 P2 与二极管 D1 串联后接至 Vin，这个绕组主要起

去磁复位的作用，同时把漏感存储的能量回传给电源。

单端正激变换器中的高频变压器，其磁通只工作在磁滞回线的第一象限，应

遵循磁通复位的原则。与脉冲变压器相同，单端变换器的变压器设计必须满足两

个条件，一是服从电磁感应定律，二是在开关管导通期间确保磁芯不会饱和。

1.1.1 工作原理

当功率管 Tr 导通时，电源电压加在变压器原边绕组 P1 上，副边绕组 P2 感应

电动势上正下负，二极管 D2 导通，D3 截止，给 LC 电路充电，同时给负载供电，

此时 P3 绕组感应电动势下正上负，二极管 D1 截止；当功率管 Tr 关断时，变压

器原边绕组 P1 开路，副边感应电动势反向，使得二极管 D2 截止，此时输出滤波
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电感 L 通过续流二极管 D3 续流，L 和 C 一起给负载供电，P3 中感应电动势也反

向，使二极管 D1 导通，将变压器绕组中储存的磁场能反馈给电源。正激电源中

的变压器仅有传递能量的作用。

1.1.2 正激电路的工作特点

在正激电源变压器中，最重要的是磁复位绕组 P3。在开关管关断后到下一

次再次开通的一段时间内，必须设法使励磁电流降回零，否则下一个开关周期中，

励磁电流将在本周期结束时的剩余值基础上继续增加，并在以后的开关周期中依

次积累起来，变得越来越大，从而导致变压器的励磁电感饱和。励磁电流会更加

迅速地增长，最终损坏电路中的开关元件，并且损坏变压器，因此，正激变压器

必须要通过磁复位绕组 P3 进行磁复位。

设功率管 Q 的工作 PWM 波占空比为 Dy，导通时，Vin 通过变压器给负载

供电；关断时，滤波电感和滤波电容给负载供电，可以得到类似的关系式：

12

12 sec

V
,

primaryout

in ondary

NDy
K

V K N
 

式中 K12，为变压器原边绕组和副边绕组的匝数比。

正激电路根据电感电路的电流在开关管开通时是否降到零分为电流连续工作模

式(CCM)和电流断续工作模式(DCM)两种。

1.2 单端反激电路

1.2.1 工作原理

由 Buck-Boost 推演并加隔离变压器后得反激变换器原理线路，如图 1-2 示。

Tr

D1

C Ro

Vin

Vout

T1

Lp

n:1

Ip
Io

Ls

图 1.2 单端反激变换器主回路电路图

当加到原边主功率开关管 Tr 的激励脉冲为高电平时，Tr 导通，直流输入电

压 Vs 加在原边绕组 PN 两端，能量储存在原边绕组 PN 内，此时因副边绕组相位

是上负下正，整流管 D1 反向偏置而截止；当驱动脉冲为低电平使 Tr 截止时，原

边绕组 PN 两端电压极性反向，使变压器副边绕组相位变为上正下负，整流管被
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正向偏置而导通，此后储存在变压器原边绕组 PN 中的磁能向负载传递释放。因

单端反激变换器只是在原边开关管导通期间储存能量，当它截止时才向负载释放

能量，故高频变压器在开关工作过程中，既起前后级隔离作用，又是电感储能元

件，即有两个作用：储能和传递能量。因此又称单端反激变换器为“电感储能式

变换器”。

1.2.2 反激电路的工作特点

在单端反激变换器中，一般有两种工作方式：一种是完全能量转换（副边绕

组电流不连续方式，DCM）。在储能周期（ ont ）中，变压器中存储的所有能量在

反激周期（ offt ）中都转移到输出端。另一种是不完全能量转换（副边绕组电流

连续方式，CCM）。储存在变压器中的一部份能量在 offt 末保留到下一个 ont 的开

始。

设功率管 Q 的工作 PWM 波占空比为 Dy，导通时，Vin 给变压器充电，关

断时，变压器给电容 C 充电，因此可以得到类似的关系式：

12

12 sec

V 1
* ,

1

primaryout

in ondary

NDy
K

V K Dy N
 



式中 K12 为变压器原边绕组 N1 和副边绕组 N2的匝数比。

1.3 正激和反激电路的工作模式

图 1.3 正激电路工作在 DCM 时的波形图

反激电源和正激电源均有两种工作模式：连续模式和断续模式。

（1）低压重载适合 CCM 模式，高压轻载适合 DCM

（2）CCM 模式不能量完全传递，开关管、线路的损耗都比较小。

（3）高压时，整流二极管的反向恢复能量损耗很大，DCM 模式时，二极管

在零偏压情况下反向偏置，损耗较小。

（4）绕组电感量大容易进入 CCM 模式
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1.4 正、反激变换器比较

1. 正激变换器的铜损较低。因为使用无气隙的铁心，电感值较高，变压器原

边与副边的峰值电流较小，因此铜损较小。在多数情况下，减少程度不足

以允许使用小一级尺寸的铁心，但会使变压器的温度稍微降低一些。

2. 正激变换器变压器副边纹波电流明显衰减。因为在一定输出负载时，输出

电感器和续流二极管的存在使得储能电容电流保持在较小的数值上。正激

变换器的能量存储于输出电感器是有利于负载的，储能电容可以取得很小，

因为它只用来协助降低输出纹波电压，而且相对反激变换器而言，电容上

通过纹波电流额定值要求小一些。

3. 正激变换器开关管的峰值电流较低。

4. 正激变换器纹波电流小，纹波电压小。

5. 相对于反激变换器而言，正激变换器线路复杂，元件成本增加，工时增加，

成本上升。

6. 由于在正激变换器中的储能电感进入不连续状态时，在辅助输出绕组上产

生过电压。如果加假负载，则效率会有所下降，所以有可能出现输出电压

升高的现象。

在同等功率输出下，正激变换器漏极峰值电流小得多。相反，反激变换器虽

然不需要电感，但有开关管（包括原边和副边绕组）和滤波电容纹波电流大的不

足。一般认为，正激变换器适合应用在低电压、大电流、功率较大的场合。反激

变换器适用在功率较小的场合，它的单台容量虽小，但它有并联工作容易、可以

自动均衡的特点。正激变换器并联却需要均衡电路，所以多台并联时采用反激变

换器为多。在高电压应用，例如 1000V 以上时也采用反激。

1.5 设计目标

1.5.1 设计反激变换器

输入：220V 交流

输出：15V 直流/2A，纹波<5%

控制芯片：UC2845

变压器：定制 58-13011B

MOSFET: K3564

二极管：MURA220T3、IN4937、MMSD914T

1.5.2 设计正激变换器

输入：220V 交流

输出：12V/80A 直流，纹波<5%

1.6 思考问题

（1） 由 220VAC 获得+15VDC 的方式有几种？
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方案一：AC 经降压变压器后再整流滤波达到 15V DC

方案二：220V AC 先整流滤波成直流是多少？再将直流变成 PWM 波形式

经降压变压器后整流滤波达到 15V DC。

问题：采用方案一对变压器有什么要求？从变压器磁芯，损耗，功率密度，

体积重量角度分析为什么不可行？

（2） 请自行分别画出反激电路工作在DCM和CCM两种模式下的电流波形图。

（3） 电力电子知识学习论坛：电源网、阿莫电子论坛、21 世纪电源网、

ALLDATASHEET 等等。

（4） 要求自主寻找 1 到 3 个反激电源和正激电源的设计原理图，分析原理，小

组讨论。

第二章 电路原理图设计

本章主要分析电路中各部分的功能作用。鉴于反激电路和正激电路输入端这

部分基本相同，因此，此处将统一分析。

2.1 输入端电路原理图分析

2.1.1 整流电路部分

正激电路和反激电路的直流输入由 220V AC 通过二极管整流桥不控整流获

得，并在整流后获得的直流端加滤波电容进行滤波，目的是减小直流端电压的脉

动成分，降低谐波成分对隔离变压器的影响。

C1

2
2

0
V

A
C

T

UC3842

C5

C4C3

C6

C7

R5 R7

R1

R6

R8

Q

R4

Vcc

R1

R2

R9

C8

D2

图 2.1 正激电路和反激电路变压器左面部分电路原理图

（1） 限流电阻不能少？选什么类型？阻值多大？

如果没有限流电阻,AC220V 经整流桥直接对输入电容充电,如果赶上交流峰

值时刻上电,而此时电容两端电压为 0V,此时电网上 310V电压处于短路状态,短路

电流大小取决于电网的内阻 Rs,以 1 欧计将有 300A 的瞬间上电电流,虽然时间短,

但会减短输入电容和整流桥的寿命,还可能对临近设备产生干扰.
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限流电阻的计算值的大小，以滤波电容 C1 所能承受的最大冲击电流为参考。

太大，会使限流电阻上分压过大，影响 Vin 的大小。阻值太小，达不到限流效果。

限流电阻的类型选择，应当考虑限流电阻的热效应。选择的电阻功率值能够

满足散热要求。

（2） 整流桥的选择

整流桥的耐压选择：一般选单管反向承受电压的 1.5 倍即可。

整流后的直流电压大小，影响滤波电容的选择。注意电容耐压，电解电容

or 薄膜电容）

（3） MOS 的选择

MOS 管选择要注意 MOS 管的耐压，以及 MOS 管的导通电阻。

（4）MOS 管 DS(Drain-Source)吸收回路

考虑变压器到功率管间的线路电感，导通时，线路电感中电流增大，储存磁

场能，关断时，线路电感中的电流不能突变，因为没有回路消耗储存的磁场能，

会使得 MOS 管漏极和源极间电压瞬间升高，形成尖峰，此时可以等效成一个不

带负载的 Boost 电路

因此选用尖峰电压吸收电路来吸收开关关断瞬间产生的尖峰电压和振铃电

压，一般选用 C、RC、RCD 等电路形式。本设计中采用 RC 吸收电路。将串联

的 RC 电路并联在 MOS 管的 D-S 间即可。R 选值比较关键，过小会发热，过大

放电缓慢。放电时间常数，t=RC，低通，滤去高频尖峰。

2.2 脉冲触发芯片 UC2845

2.2.1 芯片管脚定义

Unitrode 公司的 UC2845D(D 是贴片)是一种高性能固定频率电流型控制器,

包含误差放大器、PWM 比较器、PWM 锁存器、振荡器、内部基准电源和欠压

锁定等单元,其结构图如图 2-2 所示。其内部电路图如图 2-3 所示。

图 2.2 UC2845 芯片封装图
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图 2.3 UC2845 内部电器原理图

1 脚: 是误差放大器的输出端,外接阻容元件用于改善误差放器的增益和频率特

性。

2 脚: 是反馈电压输入端,此脚电压与误差放大器同相端的 2.5V 基准电压进行比

较,产生误差(控制)电压,误差(控制)电压变大,第 6 脚输出脉冲变窄,占空比降低,抑

制输出电压的增加,从而使输出电压稳定,而控制脉冲宽度,脉宽越宽,电源输出电

压越高,Vref 比较器高低门限为:3.6V/3.4V。

3 脚: 电流检测输入端。在外围电路中,在功率开关管(如 Mos 管)的源极串接一个

小阻值的取样电阻,将脉冲变压器的电流转换成电压,此电压送入 3 脚,控制脉宽。

此外,当电源电压异常时,功率开关管的电流增大,当取样电阻上的电压超过 1V 时,

缩小脉冲宽度使电源处于间歇工作状态,UC2845 就停止输出,有效地保护了功率

开关管。

4 脚: 定时端,内部振荡器的工作频率由外接的阻容时间常数决定，如下式所示。

当上电后，5VDC 通过 Rt 电阻给 Ct 充电,使④脚电压近似线性上升,当电压上升

到2.8V时,在振荡器内部,将定时电容器CT上的电压突然放掉,当电压下降到1.4V

时,电压又开始上升,这样就形成一个锯齿波电压。 f =
1.72

(Rt∗Ct)

5 脚: 为公共地端。

6 脚: 为推挽输出端,输出的频率是振荡频率的 1/2,内部为图腾柱式,上升、下降时

间仅为 50ns,驱动能力为±1A。输出频率是振荡频率的一半，R11 是驱动电阻，

一般为 10 到 100 欧姆，影响 GS 的上升时间和开通尖峰。

7 脚:  Vcc 是电源。VCC 比较器上下门限分别为:8.4V/7.6V,UC2845 最小工作电

压为 8.2V,此时耗电在 1mA 以下。输入电压可以通过一个大阻值电阻从高压降压

获得。芯片工作后,输入电压可在 7.6V～36V 之间波动,(内部有一个 36V 的齐纳

二极管作为稳压管,从 VCC 连接至地,它的作用是保护集成电路免受系统启动或

运行期间所产生的过高电压的破坏),低于 7.6V 就停止工作。工作时耗电约为

15mA,此电流可通过反馈电阻提供。当 Vcc 欠压,UC2845D8 参考电压输出端 8 脚

将无+5V 输出,从而导致 RC 振荡停止工作。

8 脚:  为 5V 基准电压输出端,有 50mA 的负载能力。

http://www.c114.net/keyword/·uc1u197%20?′óuc1u198%20?÷
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2.2.2 主要特性

UC2845 用于 20-50W 的小功率开关电源,管脚少,电路简单。其电气特性如下：

（1） 单输出级,可以驱动 MOS、晶体管。

（2） 自动前馈补偿。

（3） 锁存脉宽调制,用于逐周期限流。

（4） 具有精密的电压基准源(±l％),电压调整率可达 0.01%。

（5） 基准电压为 4.9～5.1V,电流模式工作频率可达 500kHz。

（6） 低启动电压和工作电流,启动电流<1mA,工作电流 15mA。

（7） 电流图腾柱输出,1A。

（8） 有欠电压锁定保护和过电流保护功能。

2.2.3 思考问题

希望同学们回去自己设计下这部分的电路，自己选择元器件，并在 datasheet

上查看相关参数。

2.3 输出端电路原理图分析

2.3.1 正激电路的输出端

图 2.4 正激电源的输出端原理图事例

从图中可以看出，该电路有两路直流输出端。一路作为正激电源目标输出端，

另一路输出电压 VCC 可以作为电路板上其他用电单元的供电电源，如 PWM 控

制芯片 UC2845 的供电电源。

该电路设计时应该注意的方面有：

（1） 反激电路中的变压器起的作用是储能（电感的作用）和变比的作用，

因此反激电路的变压器设计的时候要类似于电感的设计，一定注意磁

饱和的问题（磁芯加气隙）。

（2） 正激变压器是真正意思上的变压器，其后的拓扑本质是 Buck 电路，

所以正激就是变压器与 Buck 电路的组合演变，因此正激的输出电感，

电容均按 Buck 电路计算即可
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（3） 设计时，应当根据正激电源的输出输入电压比与占空比和变压器变比

三者之间的关系。一般的线圈匝数少的取 10 圈左右，根据线路电流

选取线圈线径，根据开关频率选取磁芯。

（4） 设计时应当考虑变压器漏感的影响

A)，在某一段时间内，初级侧虽然有正电压方波，但是不足以维持负

载电流，次级侧的所有二极管导通，负载处于续流状态，其两端的电

压为零；B)，与分布电容形成振荡回路，振荡向外辐射电磁能量，造

成 EMI 很大。

（5） 对于正激电源磁复位绕组，D4 的选择应当具备快恢复，高耐压的特

点。

（6） 正激输出相当于一个Buck电路，所以需要续流二极管D2和电感 L1，

R1,C1 和 R2,C5 均为吸收回路

（7） L1 选择：电感量太小的,电源输出纹波大,而且系统会不稳定,会引起振

荡现象,而且对输出电容的纹波电流增大,电容寿命受影响；电感量太

大了,损耗会增大,而且会引起整个系统的相位移动（电流和电压相位

差）,相位裕量不足,开环增益变小,瞬态响应变差。经尝试，取 100 到

400uH 比较好，采用铁硅铝磁环，Vo=L*∆i/∆t， ∆i=I*20%。

2.3.2 反激电路输出端

图 2.5 反击电源的输出端原理图事例

从图中可以看出，该电路也有两路直流输出端。一路作为反激电源目标输出

端，另一路输出电压 VCC 可以作为电路板上其他用电单元的供电电源，如 PWM

控制芯片 UC2845 的供电电源。

该电路设计时应该注意的方面有：

（1） 反激电路中的变压器起的作用是储能（电感的作用）和变比的作用，

因此反激电路的变压器设计的时候要类似于电感的设计，一定注意磁

饱和的问题（磁芯加气隙）。

（2） 变压器漏感的影响：

A)，使初级开关管和次级二极管上出现尖峰；B)，与分布电容形成振

荡回路，振荡向外辐射电磁能量，造成 EMI 很大。

（3） 主体是二极管 D1 和电解电容 C2（电解电容的主要作用是滤波，注意

方向）。需要增加 R1 和 C1 是 D1 的吸收缓冲回路（自行分析其工作

原理），C3 比较小，和 C2 一起滤波，R3 为假负载，防止输出电压飙

升。
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2.4 其他已定元器件参数

该课程设计为减少学生设计工作量，减少调试差异性，便于行进统一评估，

规定少部分元器件的型号和封装，便于实验室和指导老师统一采购。

2.4.1 整流桥

整流桥采用四个二极管按照不控整流桥的结构封装而成。其电路结构如下图

所示。器件型号为 KBP10M，具体参数及型号请见附录一。

图 2.6 整流桥结构及封装图

2.4.2 隔离变压器

    在正激电路和反激电路中，开关工作频率往往很高，如 10kHz—50kHz。这

就要求变压器能在这种工况下正常工作。而且变比合适的变压器的采用，开关管

和二极管两端的反向电压承受压力可以大大减小，从而降低成本，提高效率。

该设计中，变压器要求具有较大的磁能存储能力，其铁芯磁化曲线如下图。其型

号为 TWI3313V。其具体参数见附件二。

图 2.7  变压器铁芯磁化曲线
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2.4.3 功率开关管

开关管采用 MOS 型场效应晶体管。型号为 TOSHIBA 2SK3564。具体参数

见附件三。

2.4.4 二极管

主要参数：

（1） 正向平均电流 IF(AV) : 指在指定壳温下允许通过的最大工排尿正弦半波电

流的平均值，几十使用时要按有效值相等的原则进行折算来选取，同时要

考虑散热条件，频率较高时还要考虑开关损耗引起的发热，对二极管进行

降 额 使 用 ， 一 般 考 虑 1.5—2 倍 的 裕 度 。 IF(AV) = (1.5-- 2)*I 

F(AV)I  = (1.5 2)*
/ 2

RMSI


。

（2） 正向压降 UF: 在一定温度和指定的正向电流下所对应的正向电压降。

（3） 反向重复峰值电压 Urrm:指所能重复施加的方向峰值电压，使用时长安可

能承受的反向最高峰值电压的两倍来选取。

（4） 方向恢复时间 trr：为而家管恢复反向阻断特性所需要的时间。

分类：

（1） 整流二极管（Irr>5um）：正向压降低（1~2V），正向电流和反向电压额定

值都很高，可到数千安培和数千伏，多用于贡工频整流。

（2） 快恢复二极管：正向压降较高，超快恢复可达到几十纳秒，反向耐压躲在

1200V 以下，多用于高频整流或者缓冲保护电路。

（3） 肖特基二极管：反向恢复时间很短（10~40ns），正向压降低（0.4~0.8V ），

但反向耐压较低，一般小于 150V，且反向漏电流交大，多用于低电压场

合。

2.4.5 MOSFET 电力场效应管

特点：

（1） 过渡时间短，目前为工作频率最高的器件

（2） 通态电阻具有正温度系数，对并联时均流有利

（3） 为场控器件，静态时不需要驱动电流，但开关过程中需要对输入电容放电，

仍需要有一定的驱动功率，一般可以靠降低栅极驱动电路的内阻来减小栅

极回路的充放电时间，加快开关速度，但过小的栅极电阻会引起驱动回路

振荡。

（4） 通态压降（导通电阻）较大，耐压也偏低，因此多应用于开关频率高，工

作电压较低，输出功率较小的场合。

主要参数：

（1） 漏极电压 UDSS，作为额定电压;

（2） 漏极直流电流 ID 和漏极脉冲电流幅值 IDM：作为额定电流参数，实际

应用时要考虑损耗和散热情况得出壳温，由此核算电流定额，80℃时的工

作电流只有 25℃时的 70％。

（3） 栅源电压 UGS，一般要求小于 20V，适当提高栅压有利于减小导通电阻

和减小导通时间
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2.4.6 IGBT 绝缘栅晶体管(MOSFET+GTR)

特点：

集 MOSFET 驱动简单，开关频率高的优点和 GTR 导通压降低、电压、

电流容量高的优点于一体，目前容量参数经可以达到 3.3kV/1.2kA，工作

频率可达 150kHz

主要参数：

（1） 最大集射极间电压 UCES：额定电压标称值。

（2） 最大集电极电流 IC：额定电流标称值。

（3） 最大集电极功耗 PCM：正常工作温度下允许的最大耗散功率。

2.4.7 驱动电路

驱动电路的功能：

（1） 接受控制电路输出的开关控制信号，进行功率放大、隔离处理后给开关器

件的控制极提供足够大的电压或电流，使之导通或关断。

（2） 保持可靠的导通或关断状态，并尽力减小器件的导通时间和关断时间，减

小器件的开关损耗

（3） 在过电流和过电压状况下有效地进行保护，以保证器件的安全。

MOSFET 和 IGBT 栅极驱动:

（1） MOSFET 和 IGBT 均为电压驱动型器件，在栅源极（或栅射极）之间都

有数千 pf 的极间电容，为快速建立驱动电压，要求驱动电路的输出电阻

较小。

（2） MOSFET 开通的驱动电压一般取 10～15V，IGBT 开通的驱动电压一般

取 15～20V。

（3） 关断时施加一定幅值的负驱动电压（一般－5～－15V），以减小关断时间

和关断损耗

（4） 在栅极串入一个低值电阻（数欧至数十欧）以减小寄生振荡，过大的电阻

会引起开关时间延长 。

2.4.8 缓冲电路

缓冲电路又称为吸收电路，主要用于抑制器件在开关过程中产生的过电压

du/dt 或者过电流 di/dt，减小器件的开关损耗。缓冲电路可分为关断缓冲电路（或

du/dt 以及过电压抑制电路）和开通缓冲电路（或 di/dt 以及电流过冲抑制电路），

而一般我们所指的缓冲电路指关断缓冲电路，开通缓冲电路一般称为 di/dt 抑制

电路。

常用基本缓冲电路 --- 充放电型 RCD 缓冲电路 --- 保护器件，降低开关损

耗
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充放电型 RCD 缓冲电路的三个作用:

（1） 吸收过压尖峰

（2） 减缓 dUCE/dt

（3） 充电分流使开关管电流减小。

工作原理：

    T 关断时，Cs 通过 Ds 充电至 UCE；T 开通时，Cs 通过 Rs 放电至 0

RC 缓冲电路            放电阻止型 RCD 缓冲电路

充放电型 RCD 缓冲电路适用于中等容量的电路，RC 缓冲电路在小容量电

路中有应用，而放电阻止型 RCD 电路应用于大容量场合，其吸收 UCE 高于 Ed 

的尖峰电压，再通过 R 释放过冲电压的能量，因此对 R 的功耗要求大幅降低，

但这种电路不能降低器件的开关损耗。

第三章 Multisim 仿真

3.1 Multisim 软件简介

NI Multisim 是一款著名的电子设计自动化软件，与 NI Ultiboard 同属美国国

家仪器公司的电路设计软件套件。Multisim 适用于板级的模拟/数字电路板的设

计工作。它包含了电路原理图的图形输入、电路硬件描述语言输入方式，具有丰

富的仿真分析能力。Multisim 已受到国内外教师、科研人员和工程师的广泛认可，

成为业界一流的高级 SPICE 仿真标准环境。
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3.2 Multisim 使用入门

    Multisim 是一款的软件，本节以 Multisim 10.0 为例介绍该软件的使用方法和

绘制电路图仿真时的注意事项。

图 3.1 Multisim 的主窗口

主窗口主要由电路工作区、菜单栏、工具栏、元器件栏、仿真开关等组成。

进行电路仿真实验前必须先搭接好线路，仿真电路的建立主要包括以下几个过程：      

1) 新建电路文件。    

2) 设置电路工作窗口。    

3) 选择和放置元器件。

4) 连接线路。      

5) 设置元器件参数。     

6) 调用和连接仪器。

3.2.1 新建电路文件

选择 File→New 创建新电路文件，系统自动产生“circuit1”的电路文件，在

电路文件未保存之前，其文件名为“circuit1.ms10”。选择 File→Save 将新建的

文件保存在指定的文件夹里，下面就可以在该工作窗口内进行仿真电路的创建了。
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图 3.2 新建电路文件

3.2.2 设置电路工作窗口

在菜单栏中选择 Options→Sheet Properties…，或者直接在电路工作区的空白

处单击鼠标右键选择 Properties，即可进入页面属性窗口对当前页面的电路、工

作区、布线、字体、PCB、可视化等进行设置。

图 3.3 设置页面属性

在 Workspace 选项卡里可以选择页面大小。建议在 Sheet size 项选择标准大

小，如 A4。也可以在 Custom size 里通过修改页面宽度和高度来定制页面大小。
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图 3.4 页面大小设置

本课程仿真时采用系统默认设置基本可以满足设计需求。当元器件较多，页

面大小不够时可以通过上述方法修改页面大小。

3.2.3 选择和放置元器件

    在电路工作区单击鼠标右键选择 Place Component，会弹出一个选择元器件

的窗口如图 3.5 所示。

图 3.5 选择元器件

首先根据元器件的类型选择 Group，比如常用的各种电源、电压 PWM 发生

器和地在 Sources 中可以找到。Family选项为 Group 的子类，如通过 Group：Diodes

→Family：FWB 可以找到各种型号的整流桥。窗口右下角有元件的生产商和封
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装信息（本课程仿真不要求）。确认无误后单击 OK，系统会自动关闭该窗口，

同时刚才选定的元件会随着光标的移动而改变位置。将元件移动到合适的位置，

单击鼠标左键，元件就被放置好了。

图 3.6 搜索整流桥

3.2.4 连接线路

1.自动连线      

自动连线时将光标指向第一个元器件的管脚上，光标变为“＋”号，单击鼠

标左键开始连线，移动光标屏幕将自动拖出一条连线，将光标移动到下一个元器

件管脚处，再次单击鼠标左键，系统自动产生一条连线，如图 3.7 所示。  

图 3. 7 自动连线

2.手工连线      

在电路图比较大时，自动布线时可能会出现不必要的绕行，造成电路图比较
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复杂，读图困难，此时可以选择手工连线。  手工连线可以在光标移动过程中改

变导线的路径，即每单击一次鼠标左键就可以改变一次导线路径，如图 3.8所示。

图 3.8 手工连线

3.修改走线      

某些线连接好后，想进行局部调整，可以单击该连线，连线上出现很多拖动

点，单击两拖动点之间的连线，光标变成双箭头，拖动箭头实现正交修改；如果

单击拖动点，则该点上出现三角箭头，此时拖动箭头实现任意角度的走线，如图

所示。

图 3.9 修改走线
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3.2.5 设置元器件参数。  

双击一个元件，系统会弹出该元件的属性窗口。根据实际的应用需要修改元件的

参数，修改时要注意选择的参数单位是否符合要求。修改成功后单击 OK。

图 3.10 修改元件属性

    由于元件种类丰富无法一一介绍每种元件的修改方法，这里介绍一个小经验。

大家遇到困难时，可以点击属性窗口下方的 Info 按键，这时会弹出一个

Component Reference 帮助窗口，如图所示。这里面详细介绍了元件的详细信息。

图 3.11 元件参考

点击左边栏元件名称前的“+”号，下拉出元件的特征函数、模型、参数和

默认参数等。参考这些说明，大家可以获取更详细的使用信息。
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图 3.12 元件详细信息

3.2.6 调用和连接仪器

   Multisim 提供一系列虚拟仪表，您要用这些仪表测试电路的行为。这些仪表

的使用和读数与真实的仪表相同，感觉就像实验室中使用的仪器。使用虚拟仪表

显示仿真结果是检测电路行为最好、最简便的方法。

图 3.13 仪器栏
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系统主界面的右边栏为常用的测量仪器。将光标移到任意一个仪器的图标上，

会提示该仪器的名称。最常用的是示波器 。单击该图标，进入示波器摆放模

式。

图 3.14 示波器的使用

     示波器具有 A、B 两个通道。将通道的﹢、-分别连接待测线路的两端。

3.2.7 仿真运行

电路连接好之后就可以单击工具栏中的 Run 图标如图 3.15 所示，进行仿真

运行的。

图 3.15 仿真运行

双击打开示波器，可以观测相应的波形。

图 3.16 示波器界面
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3.3 Multisim 在本设计中注意事项

3.3.1 关于参数选型

合适的不仅有助于仿真错误的减少，而且有助于利用 Altium Desiger 设计

PCB 板的工作量。在本设计中，电阻电容等元器件的选型不仅要考虑相关器件

的主要参数，还应该考虑到相关器件的封装，体积大小，这就需要从元器件的型

号出发，阅读该器件的参数说明（datasheet）。

下文将介绍一些典型器件的选型注意项，包括但不限于限流电阻，整流桥，变压

器。

(1) 电流电阻选型时，除了选择合适的电阻值，还应该考虑到对于 220VAC 这一

“强电”输入，要求电阻应该有良好的散热性能。满足此类的电阻体积往往较

大。

(2) 整流桥选型时，要考虑整流桥在运行时需要长时间通过较大的电流而产生发

热现象，因此也应该考虑相关型号的散热性能。

(3) 变压器选择时，要求注意变压器的变比会影响输入输出电压的变比。应当从

该变比出发，选择合适的变比。

选择变压器

3.3.2 Multisim 的调试

采用 Multisim 进行调试时，可能会出现一些报错，警告等提示。设计者应

当根据相关提示信息发现故障并改正。以下汇总一些本设计中可能出现的故障，

并提出了相关的原因分析和解决方法。

(1) 输出端没有输出

可能是线路接触不通造成的，检查是否有相关线路没有连接起来，导致线路

开路。

原因还可能是脉冲触发芯片 UC2845 没有正常工作。检查芯片供电电源 Vcc

是否满足供电要求（8.6V< Vcc <34V）。该供电电源可已先在模型中加入 DC 直

流源模型给芯片供电，在排除其他故障后，再采用反击电源输出端 Vout 和变压

器输入端电压(即整流桥输出电压)联合供电。

(2) 输出端电压过小

可能是选取的整流桥二极管压降或者限流电阻的阻值过大，导致整流桥的有

效输出电压过低。正常值为 120V—150V。可调整整流桥二极管参数或者限流电

阻的阻值来改善整流桥有效电压输出值。

也可能是由于变压器变比选取过大，导致变压器副边线圈的感应电压过小。

应当调整变压器变比（一般为 10：1 左右）。

(3) 输出电压波形差

输出电压波形出现尖峰脉冲或者“振铃”现象。如下图（a）所示。

可能原因是在输出端二极管或者功率开关管漏极和源极间没有加入RC吸收

回路，不能滤除掉电路中的高频震荡信号，以及由于电路寄生电感导致的 di/dt

尖峰信号。可加入合适参数的 RC 吸收回路。
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（a）电压尖峰和“振铃”现象         （b）加入 RC 吸收电路后改善效果

(4) 软件运行过慢，等待时间会很长

原因可能是软件的仿真步长设置问题。可通过 simulate 下拉菜单中的

Interactive simulation setting 进行调节，调整最大步长时间长度，加快运行速度。

注意，步长过大时，有可能会导致仿真计算不收敛而报错。

第四章 利用 Altium Designer 软件设计 PCB

4.1 创建一个新的 PCB 工程

在 Altium Designer 里，一个工程包括所有文件之间的关联和设计的相关设

置。一个工程文件，例如 xxx.PrjPCB，是一个 ASCII 文本文件，它包括工程里

的文件和输出的相关设置，例如，打印设置和 CAM 设置。与工程无关的文件被

称为"自由文件"。与原理图和目标输出相关联的文件都被加入到工程中，例如

PCB，FPGA，嵌入式(VHDL)和库。当工程被编译的时候，设计校验、仿真同步

和比对都将一起进行。任何原始原理图或者 PCB 的改变都将在编译的时候更新。

所有类型的工程的创建过程都是一样的。本章以 PCB 工程的创建过程为例

进行介绍，先创建工程文件，然后创建一个新的原理图并加入到新创建的工程中，

最后创建一个新的 PCB，和原理图一样加入到工程中。作为本章的开始，先来

创建一个 PCB 工程：

图 4.1 PCB 工程的创建
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1.选择 File>>New>>Project>>PCB Project，或在 Files 面板的内 New 选项中

单击 Blank Project (PCB)。如果这个选项没有显示在界面上则从 System 中选择

Files。也可以在 Altium Designer 软件的 Home Page 的 Pick a Task 部分中选择

Printed Circuit Board Design，并单击 New Blank PCB Project。

2. 显示 Projects 面板框显示在屏幕上。新的工程文件 PCB_Project1.PrjPCB

已经列于框中，并且不带任何文件，如图 4.1 所示。

3.重新命名工程文件（用扩展名.PrjPCB），选择 File>>Save Project As。保

存于您想存储的地方，在 File Name 中输入工程名 Multivibrator.PrjPCB 并单击

Save 保存。

下面我们将会创建一个原理图文件并添加到空的工程中。这个原理图就是教

程中的例子非稳态多谐振荡器。

4.1.1 创建一个新的电气原理图

    通过下面的步骤来新建电路原理图：

1.选择 File>>New>>Schematic，或者在 Files 面板内里的 New 选项中单击

Schematic Sheet。在设计窗口中将出现了一个命名为 Sheet1.SchDoc 的空白电路

原理图并且该电路原理图将自动被添加到工程当中。该电路原理图会在工程的

Source Documents 目录下。

2.通过文件 File>>Save As 可以对新建的电路原理图进行重命名，可以将通

过文件保存导航保存到用户所需要的硬盘位置，如输入文件名字

Multivibrator.SchDoc 并且点击保存。

当用户打开该空白电路原理图时，用户会发现工程目录改变了。主工具条包

括一系列的新建按钮，其中有新建工具条，包括新建条目的菜单工具条，和图表

层面板。用户现在就可以编辑电路原理图了。

用户能够自定义许多工程的外观。例如，用户能够重新设置面板的位置或者

自定义菜单选项和工具条的命令。
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现在我们可以在继续进行设计输入之前将这个空白原理图添加到工程中，如

图 4.2。

图 4.2 新建电路原理图

4.1.2 添加电路原理图到工程当中

如果添加到工程中的电路原理图以空文档的形式被打开，可以通过在工程文

件名上点击右键并且在工程面板中选择 Add Existing to Project 选项，选择空文

档并点击 Open。更简单的方法是，还可以在 Projects 面板中简单地用鼠标拖拽

拉空白文档到工程文档列表中的面板中。该电路原理图在 Source Documents 工程

目录下，并且已经连接到该工程。

4.1.3 设置原理图选项

在绘制电路原理图之前要做的第一件事情就是设置合适的文档选项。完成下

面步骤：

1.从 menus 菜单中选择 Design>>Document Options ，文档选项设置对话框

就会出现。通过向导设置，现在只需要将图表的尺寸设置唯一改变的设置只有将

图层的大小设置为 A4。在 Sheet Options 选项中，找到 Standard Styles 选项。点

击到下一步将会列出许多图表层格式。

2.选择 A4 格式，并且点击 OK，关闭对话框并且更新图表层大小尺寸。

3.重新让文档适合显示的大小，可以通过在中选择 View>>Fit Document。在

Altium 中，可以通过设置热键的方法让菜单处于激活状态。任何子菜单都有自己

的热键用来激活。
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例如，前面提到的View>>Fit Document ，可以通过按下V键跟D键来实现。

许多子菜单，比如 Eidt>>DeSelect 能直接用一个热键来实现。激活

Eid>>DeSelect>>All on Current Document，只需按下 X 热键，并且按下 S 热键即

可。

    下面将介绍电路原理图的总体设置。

1.选择 Tools>>Schematic Preferences ，来打开电路原理图偏好优先设置对话

框。这个对话框允许用户设置适用于所有原理图定的为全球局配置参数的偏好设

置，适用于全部原理图。

2.在对话框左边的树形选项中单击 Schematic-Default Primitives，激活并使能

Permanent 选项。单击 OK 以关闭该对话框。

3.在您开始设计原理图前，保存此原理图，选择 File>>Save [快捷键：F，S]。

4.2 绘制电路原理图

接下来可以开始画电路原理图。本章将使用如图 4.3 所示的电路图为例进行

讲解。这个电路是由两个 2N3904 三极管组成的非稳态多谐振荡器。

图 4.3 示例电路图

4.2.1 加载元件和库

Altium Designer 为了管理数量巨大的电路标识，电路原理图编辑器提供了强

大的库搜索功能。虽然元件都在默认的安装库中，但是还是很有必要知道如何通

过从库中去搜索元件。按照下面的步骤来加载和添加图 4.3 电路所需的库。

首先我们来查找型号为 2N3904 的三极管。

1.点击 Libraries 标签显示 Library 面板，如图 4.4。

2.在 Library 面板中点击 Search in 按钮，或者通过选择 Tools>>Find Com-

ponent，来打开 Libraries Search 对话框，如图 4.5 所示。
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3.对于这个例子必须确定在 Options 设置中，Search in 设置为 Components。

对于库搜索存在不同的情况，使用不同的选项。

4.必须确保 Scope 设置为 Libraries on Path 并且 Path 包含了正确的连接到库

的路径。如果在安装软件的时候使用了默认的路径，路径将会是 Library。可以

通过点击文件浏览按钮来改变库文件夹的路径。对于这个例子还需得确保

Include Subdirectories 复选项框已经勾选。

5.为了搜索所有 3904 的所有索引，在库搜索对话框的搜索栏输入*3904*。

使用*标记来代替不同的生厂商所使用的不同前缀和后缀。

6.点击 Search 按钮开始搜索。搜索启动后，搜索结果将在库面板中显示。

图 4.4 库面板
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图 4.5 库搜索对话框

7.点击 Miscellaneous Devices.IntLib 库中的名为 2N3904 的元件并来添加它。

这个库拥有所有的可以利用于仿真的 BJT 三极管元件标识。

8.如果选择了一个没有在库里面安装的元件，在使用该元件绘制电路图前，

会出现安装库的提示。由于 Miscellaneous Devices 已经默认安装了，所以该元件

可以使用。

在库面板的最上面的下拉列表中有添加库这个选项。当点击在列表中一个库

的名字，在库里面的所有元件将在下面显示。可以通过元器件过滤器快速加载元

件。

4.2.2 在电路原理图中放置元件

第一种要在电路图中放置的元件为三极管，Q1 和 Q2。电路图的大概布局

将参照图 4.3 所示。

1.选择 View>>Fit Document 让，原理图表层全屏显示。

2.通过 Libraries 快捷键来显示库面板。

3.Q1 和 Q2 为 BJT 三极管，所以从 Libraries 面板顶部的库下拉列表中选择

Miscellaneous Devices.IntLib 库激活当前库来激活这个库。

4.使用 filter 快速加载所需要的元件。默认的星号*可以列出所有能在库里找

到的元件。设置 filter 为*3904*，将会列出所有包含文本 3904 的元件。

5.2N3904 将选择该元件 2N3904，然后点击 Place 按钮。或者，直接双击该

元件的文件名。光标会变成十字准线叉丝状态并且一个三极管紧贴着光标。现在

正处于放置状态。如果移动光标，三极管将跟着移动。
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6. 放置器件在原理图之前，应该先设置其属性。当三极管贴着光标，点击

TAB 键，将打开 Component Properties 属性框。把该属性对话框设置成如图 4.6

所示。

图 4.6 Component Properties 属性框

7.在 Properties 对话框中，在 Designator 栏输入 Q1。

8.接下来，必须检查元件封装是否符号 PCB 的要求。在这里，使用的集成

库对于中已经包含了封装的模型以及和仿真模型电路都已经包括了。确认调用了

封装 TO-92A 封装模型包含在模块中。保持其他选项为默认设置，并点击 OK 按

钮关闭对话框。

    现在开始放置器件：

1.移动光标，放置三极管在中间靠左的位置。点击鼠标或者按下 ENTER 键

来完成放置。

2.移开光标，在原理图上将出现该三极管，并且仍旧处于放置器件状态，三

极管仍然贴着光标。Altium Designer 的功能是允许反重复放置同一器件。所以，

现在放置第二个三极管。由于该三极管跟原来的一样，因此所以在放置器件时不

需要再次编辑器件的属性。Altium Designer，将自动增加 designator 的名字中的

数字后缀。所以这次放置的三极管的 designator 将为 Q2。

3.当参照示例电路图（图 4.3）日志的时候，将发现其实 Q2 为 Q1 的镜像。

通过按下 X 键来改变放置器件的方向。这将使元件沿水平方向方向翻转。
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4.移动光标到 Q1 的右边，为了使得位置更加准确，点击 PAGE UP 键两次

来放大画面。这样可以看到栅格线。

5.点击 ENTER 来放置 Q2。每次放置好一个三极管，又会出现一个准备放置

的三极管。

6.所有三极管都放置完毕后，可以通过点击右键或按下 ESC 键来退出放置状

态。光标又回到的原来的样子。

    接下来放置四个电阻：

1.在库面板中，激活 Miscellaneous Devices.IntLib 库。

2.设置 filter 为 res1。

3.点击 Res1 来选择该器件，这样一个电阻元件符号将贴着光标。

4.按下 TAB 来编辑属性。在属性对话框中，设置 designator 为 R1.

5.在模模型块列表中确定 AXIAL-0.3 已经被包含。

6.PCB 元件的内容由原理图映射过去，所以这里并且设置 R1 的大小为 100k。

7.由于不需要仿真，所以设置 Value 参数中的 Visible 选择为非使能。

8.按下空格键使得电阻旋转 90°，位于正确的方向。

9.把电阻放置在 Q1 的上方，按下 ENTER 完成放置。不用担心如何连接电

阻到三极管，在连线部分将会做说明。

10.接下来放置一个 100K 的电阻 R2 于 Q2 的上方。DesigntorDesignator 的标

号会自动增加。

11.剩下的两个电阻 R3 和 R4 的大小为 1k，通过 TAB 键设置它们的

CommnetComment 为 1k，确认 Value 的 Visible 选项非使能，点击 OK 按钮关闭

对话框。

12.放置 R3 和 R4 如图 4.1 所示，并通过点击右键或 ESC 退出。

    现在放置两个电容：

1.电容器件也在 Miscellaneous Devices.IntLib 库中，该库已经选择了。

2.在 Libraries 面板的元器件过滤区内输入 cap 于 filter。

3.点击 CAP 来选择该器件，点击 PLACE，这样一个电容元件符号将贴着光

标。

4.通过 TAB 键设置电容属性。设 disigatordesignator 为 C1，Comment 为 20n，

Visible 为非使能，PCB 封装为 RAD-0.3。点击 OK。
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跟设置电阻一样，如果需要仿真，则需要设置 Value 的值。这里不需要仿真，

所以 Value 设置为非使能。

5.跟前面一样，放置电容。

6.通过右键或 ESC 退出。

    最后一个需要放置的器件是 connector，位于Miscellaneous Connectors.IntLib。

1. 在库面板中，选择 Miscellaneous Devices.IntLib 库。需要的 connector 为

2 排针，所以 filter 设置为*2*。

2. 点击 Header 2 来选择该器件，点击 PLACE。通过 TAB 键设置电容属性。

设 disigatordesignator 为 Y1，Visible 为非使能，PCB 封装为 HDR1X2。点击 OK。

3.在放置前，按下 X 键，使得器件处于垂直方向。然后放置 connector 器件。

4.退出放置。

5.File>>Save 来保持原理图。

    现在已经放置完所有的元件。元件的摆放如图 4.7，可以看出这样的放置留

了很多空间来

图 4.7 所有元器件放置完成的原理图

连线元件管脚。这一点非常重要，因为不可能连接位于管脚正上方的管脚。

如果想移动元件，点击，并保持，拖动元件到用户想要的位置。

4.2.3 电路连线

    连线是处理电路中不同元件的连接。按照图 4.3 来连接电路原理图，完成下

面的步骤。
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1.为了使电路图层美观，可以使用 PAGE UP 来放大，或 PAGE DOWN 来缩

小。保持 CTRL 按下，使用鼠标的滑轮可以放大或缩小图层。

2.首先连接电阻 R1 到三极管 Q1。在菜单中选择 Place>>Wire 或者在连线工

具条中点击 Wire 来进入绘线模式。光标会变成 crosshair 十字准线模式。

3.把光标移动到 R1 的最下面，当位置正确时，一个红色的连接标记会出现

在光标的位置。这说明光标正处于元件电气连接点的位置。

4.单击或者按下 ENTER 键来确定第一个连线点。移动光标，会出现一个从

连接点到光标位置，随着光标延伸的线。

5.在 R1 的下方 Q1 的电气连接点的位置放置第二个连接点，这样第一根连

线就快画好了。

6. 把光标移动到 Q1 的最下面，当位置正确时，一个红色的连接标记会出现

在光标的位置。单击或者按下 ENTER 键来连接 Q1 的基点。

7.光标又重新回到了十字准线 cross hair 状态，这说明可以继续画第二跟线

了。可以通过点击右键或者按下 ESC 来完全退出绘线状态，不过现在还不

要退出。

8.现在连接 C1 到 Q1 和 R1。把光标放在 C1 左边的连接点上，单击或者按

下 ENTER，开始绘制一个新的连线。水平移动光标到 R1 与 Q1 所处直线的

位置，电气连接点将会出现，单击或按下 ENTER 来连接该点。这样两根直

接便自动的连接在一起了。

9.按照图 4.3 绘制电路剩下的部分，如图 4.8。

图 4.8 完成布线的原理图

10.当完成所有连线的绘制时，单击右键或按下 ESC 来退出画线模式。光标

回到原来的状态。
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11.如果想移动元件跟连接他的连线，当移动元件的时候按下并保持按下

CTRL 键，或者选择 Move>>Drag。

4.2.4 网络和网络标记

    每个元件的管脚连接的点都形成一个网络。例如一个网络包括了 Q1 的基点，

R1 的一个脚和 C1 的一个脚。

    为了能够简单的区分设计中比较重要的网络，可以设置网络标记。接下来放

置两个电源网络标记：

1.选择 Place>>Net Label。一个带点的框将贴着光标。

2.在放置前，通过 TAB 键打开 Net Label dialog。

3.在 Net 栏输入 12V，点 OK 关闭。

4.在电路图中，把网络标记放置在连线的上面，当网络标记跟连线接触时，

光标会变成红色十字准线 red cross。如果是一个灰白十字准线的 cross，则

说明放置的是管脚。

5.当完成第一个网络标记的绘制，仍处于网络标记模式，在放置第二个网络

标记前，可以按下 TAB 键，编辑第二个网络。

6.在 Net 栏输入 GND，点击 OK 关闭。然后放置标记。

7. 在电路图中，把网络标记放置在连线的上面，当网络标记跟连线接触时，

光标会变成 red cross 红色十字准线。单击右键或按下 ESC 退出绘制网络标

记模式。

8.选择 File>>Save ，保存电路图同时保存项目。

    恭喜用户完成第一使用 Altium Designer 绘制的电路原理图。在把原理图变

成电路板之前，必须设置项目的选项。

4.3 设置工程选项

工程选项包括了：Error Checking Parameters、Error Reporting、Connectivity 

Matrix、Class Generator、Comparator Setup、ECO Generation、Output Paths and 

Netlist Options（输出路径和网表）、Multi-Channel Naming formats、Default Print 

setups、Search Paths 以及任何用户想制定的工程元素。当编译工程的时候，

Altium Designer 将会用到这些设置。
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图 4.9 工程选项的设置

当编译一个工程时，将用到电气完整性规则来校正设计。当没有错误的时候，

重编译的原理图设计将被装载进目标文件。例如通过生成 ECOs 来产生 PCB 文

件。工程允许比对源文件和目标文件之间存在的差异，并同步更新两个文件。

所有与工程相关的操作，都可在 Project 对话框的 Options（Project>>Project 

Options）里设置，如错误检查，文件对比，ECO generation。具体请参看图 4.9。

工程输出，例如装配输出和报告可以在 File 菜单选项中设置。用户也可以在

Job Options 文件（File>>New>>Output Job File）中设置 Job 选项。更多关于工程

输出的设置如下所示。

选择 Project>>Project Options，某个工程的选项对话框便会打开，在这个对

话框中可以设置任意一个与工程相关的选项。如图所示为怎样改变 Error Re-

porting 中各项的报告方式。

4.3.1 检查原理图的电气属性

在 Altium Designer 中原理图图表不仅仅是简单的图，它包括了电路的电气

连接信息。用户可以运用这些连接信息来校正自己的设计。当编译工程时，Altium 

Designer 将根据所有对话框中用户所设置的规则来检查错误。
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4.3.2 设置 Error Reporting

Error Reporting 用于设置设计草图检查。Report Mode 设置当前选项提示的

错误级别。级别分为 No Report， Warning， Error， Fatal Error，点击下拉框选

择即可，如上图所示。

4.3.3 设置 Connection Matrix

Connection Matrix 界面显示了运行错误报告时需要设置的电气连接，如各个

引脚之间的连接，可以设置为四种允许类型。如图所示的矩阵给出了一个原理图

中不同类型连接点的图形的描绘，并显示了他们之间的连接是否设置为允许。

如图 4.10 中所示的矩阵图表，先找出 Output Pin，在 Output Pin 那行中找到

Open Collector Pin 列，行列相交的小方块呈橘黄色，这说明在编译工程时，Output 

Pin 与 Open Collector Pin 相连接会是产生错误的条件。

图 4.10 设置 Connection Matrix

用户可以根据自己的要求设置任意一个类型的错误等级，从 no report 到 fatal 

error 均可。右键可以通过菜单选项控制整个矩阵。

点击两种连接类型的交点位置，例如 Output Sheet Entry 和 Open Collector 

Pin 的交点位置。点击直到改变错误等级。
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4.3.4 设置 Comparator

Comparator 界面用于设置工程编译时，文件之间的差异是被报告还是被忽略。

选择的时候请注意选择，不要选择了临近的选项，例如不要将 Extra Component 

Classes 选择成了 Extra Component。

图 4.11 设置 Comparator 

点击 comparator 界面，在 Asscoiated with Component 部分找到 Changed Room 

Definitions，Extra Room Definitions 和 Extra Component Classes 选项。

将上述选项的方式通过下拉菜单设置为 Ignore Differences，如图 4.11 所示。

现在用户便可以开始编译工程并检查所有错误了。

4.4 编译工程

编译工程可以检查设计文件中的设计草图和电气规则的错误，并提供给用户

一个排除错误的环境。我们已经在 Project 对话框中设置了 Error Checking 和

Connection Matrix 选项。

要编译多频振荡器工程，只需选择 Project>>Compile PCB Project。

当工程被编译后，任何错误都将显示在 Messages 上，点击 Messages 来查看

错误（View>>Workspace Panels>>System>>Messages）。工程已经编译完后的文

件，在 Navigator 面板中将和可浏览的平衡层次（flattened hierarchy），元器件，

网络表和连接模型一起，被将列出所有对象的连接关系在 Navigator 中。
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如果电路设计的完全正确，Messages 中不会显示任何错误。如果报告中显

示有错误，则需要检查电路并纠正确保所有的连线都是正确的。

    现在故意在电路中引入一个错误，再编译一次工程。

在设计窗口的顶部点击激活 Multivibrator.SchDoc。选中 R1 和 Q1 的 B 极之

间的连线，点击 DELETE 键删除此线。再一次编译工程（Project>>Compile PCB 

Project）来检查错误。Messages 中显示警告信息，提示用户电路中存在未连接的

引 脚 。 如 果 Messages 窗 口 没 有 弹 出 ， 选 择 View>>Workspace Pan-

els>>System>>Messages。

双击 Messages 中的错误或者警告，编译错误窗口会显示错误的详细信息。

从这个窗口，用户可以点击错误直接跳转到原理图相应的位置去检查或者改正错

误。

下面将修正上文所述的原理图中的错误

点击激活 Multivibrator.SchDoc。

在菜单中选择 Edit>>Undo，或者使用快捷键 Ctrl+Z，原先被删除的线将恢

复原状。

检查 Undo 操作是否成功，重新编译工程（Project>>Compile PCB Project）

来检查错误。这时 Messages 中便会显示没有错误。

在菜单中选择 View>>Fit All Objects，或者使用快捷键 V，F，来恢复原理图

预览并保存没有错误的原理图。

保存工程文件。

现在已经完成了设计并且检查过了原理图，可以开始创建 PCB 了。

4.5 创建一个新的 PCB 文件

在将原理图设计转变为 PCB 设计之前，需要创建一个新的 PCB 和至少一个

板外形轮廓（board outline）。在 Altium Designer 中创建一个新的 PCB 的最简单

的方法就是运用 PCB 板向导，它可让您根据行业标准选择自己创建的自定义板

的大小。在任何阶段，都可以使用后退按钮检查或修改该向导的之前页面。
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图 4.12 PCB 板向导

    用 PCB 向导创建一个新的 PCB 用的 PCB 向导，步骤如下：

1. 创建一个新的 PCB，点击 PCB Board Wizard，在 Files 底部的 New from 

Template 选项内点击 PCB Board Wizard 部分。如果在屏幕上没有显示此选项，

按一下向上箭头图标关闭一些上层上面的选项。

2. 打开 PCB Board Wizard 向导界面，单击下一步继续。

3. 设置测量单位 Imperial，例如 1000mil = 1 英寸。

4. 向导的第三页可选择需要的板纲要形。本页将确定我们自己的电路板尺

寸。从板纲要形列表中选择 Custom，并点击下一步。

5. 在下一页，输入自定义板的选项。对于例子给出的电路，2 × 2 英寸的板

便足够了。在Width和Height中选择Rectangular和 type 2000。取消选择Title Block

＆Scale，Legend String 和 Dimension Lines。单击 Next 继续。

6. 此页用于选择板的层数。例子中的电路需要两层信号层而并不需要电源

层。单击 Next 继续。

7. 选择 thruhole vias only 设置设计中的孔类型，并点击 Next。

8. 下一页用于设置元件/布线选项。选择 Through-hole components 选项并设

置 One Track 与临近焊盘之间可以通过的线的数量。单击 Next。

9. 下一页用于设置一些设计规则，如线的宽度和孔的大小。离开选项则设

置为默认值。单击下 Next。

10. 单击 Finish。PCB Board Wizard 已经设置完所有创建新板所需的信息。

PCB 编辑器现在将显示一个新的 PCB 文件，名为 PCB1.pcbdoc。
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11. PCB 文件显示出一个预设大小的白色图纸和一个空板（黑色为底，带栅

格），如图 4.13 所示。如果需要关闭，选择 Design>>Board Options，并在板设

置对话框中取消选择 Display Sheet。用户可以用 Altium Designer 的其它 PCB 模

板来添加边界，栅格参考和标题。

    如需了解更多有关 board shapes，sheets 和 templates，请翻阅参阅 Preparing the 

Board for Design Transfer 手册。

图 4.13 PCB 文件

12. 现在图纸已关闭，如需显示板的形状，选择 View>>Fit Board [快捷键: V，

F]。

13. PCB 文件自动添加（连接）工程并被列在 Projects 中源文件里工程名的

下方。通过选择 File>>Save As 重新命名新的 PCB 文件（带.PcbDoc 扩展名）。

浏览到用户想存储 PCB 的位置，在 File Name 里键入文件名 multivibrator.pcbdoc，

并点击 Save。

如果要将 PCB 文件作为自由文件添加到一个已经打开的工程中，则需在

Projects 中右键单击 PCB 工程文件，并选择 Add Existing to Project。选择新的 PCB

文件名并点击打开。 现在 PCB 文件已经被列在 Project 下的 Source Documents

中，并与其它工程文件相连接。用户也可直接将自由文件拖拉到工程文件下。保

存工程文件。
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4.6 导入设计

在将原理图的信息导入到新的 PCB 之前，请确保所有与原理图和 PCB 相关

的库是可用的。因为只有默认安装的集成库被用到，所以封装已经被包括在内。

如果工程已经编译并且原理图没有任何错误，则可以使用 Update PCB 命令来产

生 ECOs（Engineering Change Orders 工程变更命令），它将把原理图的信息导

入到目标 PCB 文件。

图 4.14 信息导入

将原理图的信息转移到目标 PCB 文件：

1. 打开原理图文件，multivibrator.schdoc。

2. 选择 Design>>Update PCB Document（multivibrator.pcbdoc）。该工程被编

译并且工程变更命令对话框显示出来，如图 4.14 所示。

3. 点击 Validate Changes。如果所有的更改被验证，状态列表(Status list)中将

会出现绿色标记。如果更改未进行验证，则关闭对话框，并检查 Messages

框更正所有错误。

4. 点击 Execute Changes，将更改发送给 PCB。当完成后，Done 那一列将被

标记。

5. 单击 Close，目标 PCB 文件打开，并且已经放置好元器件，结果如图 4.15

所示。如果用户无法看到自己电路上的元器件，请使用快捷键

V,D(View>>Document)。

图 4.15 元器件封装放置完成
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4.7 印刷电路板（PCB）的设计

现在，我们开始摆放在 PCB 上的元器件及进行布线。

4.7.1 PCB 工作环境的设置

在我们开始摆放元器件在板上之前，我们需要对 PCB 工作环境进行相关设

置，例如：栅格、层以及设计规则。PCB 编辑工作环境允许 PCB 设计在二维及

三维模式下表现出来。

二维模式是一个多层的、理想的普通 PCB 电路设计的环境，如放置元器件，

电路和连接。三维模式对检验用户的设计的表面及内部电路都非常有用（三维模

式不支持提供二维模式下的全部功能） 。您可以通过：File>>Switch To 3D，或

者 File>>Switch To 2D[快捷键为 2（二维）、3（三维）]来切换二维与三维模式。

栅格

在开始摆放元器件之前我们必须确保我们的所用栅格的设置是正确的。所有

放置在 PCB 工作环境下的对齐的线组成的栅格称为 snap grid 捕获栅格。此栅格

需要被设置以配合用户打算使用的电路技术。

我们的教程中的电路使用具有最小的针脚间距 100mil 的国际标准元器件。

我们会设定 snap grid 为最小间距的公因数，例如 50mil 或 25mil ，以便使所有

的元器件针脚可以放置在一个栅格点上。此外，我们的板的线宽和安全间距分别

是 12mil 和 13mil（为 PCB Board Wizard 所用的默认值） ，最小平行线中心距

离为 25mil。因此，最合适 snap grid 的设置是 25mil。
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图 4.16 栅格的设置

设置 snap grid 需完成以下步骤：

选择 Design>>Board Options[快捷键分别为：D、O] 打开板 Options 对话框。

利用下拉列表或输入数字设置 Snap Grid 和 Component Grid 的值为 25mil。请注

意，此对话框也可以用来界定 Electrical Grid。这一栅格作用于用户放置电气对

象的时候;它凌驾于与 snap Snap gridGrid 和 snap 电气的对象在 Component Gird

一起使用。单击 OK 以关闭该对话框。

让我们设置其他可以令放置元器件更容易的 Options。

选择 Tools>>Preferences[快捷键：T、P]打开偏好设定对话框。按下 PCB 

Editor-General在对话框中的选择树（左侧面板）显示PCB Editor-General的页面。

在编辑 Options 部分，确保 Snap to Center 的选项是启用的。这可确保当您"拖拉"

一个元器件并放置它的时候，光标是设定为元器件的参考点。

按下 PCB Editor-Display。在 DirectX Options 部分的页面，选中 Use DirectX 

if possible 的选项。如图 4.16 所示。这将使我们能够利用最新的 3D 视图模式。

按下 OK 关闭优先偏好设定对话框。

    注： Altium Designer 的 3D 视图模式，需要 DirectX 9.0c 的和 Shader Model 

3 或更高版本上运行，以及一个合适的图形卡。如果用户不能运行 DirectX 的用

户将被限制使用三维视图。
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4.7.2 定义层堆栈和其他非电气层的视图设置

View Configurations 包括许多关于 PCB 工作区二维及三维环境的显示选项

和适用于 PCB 和 PCB 库编辑的设置。保存任何 PCB 文件时，最后使用的视图

设置也会被随之保存。这使得它可被 Altium Designer 的另一个使用其关联视图

设置的实例所启调用。视图设置（View Configurations）也可以被保存在本地和

被使用并用于任何时候的任何 PCB 文件。用户打开任何没有相关的视图设置

（View Configurations）的 PCB 文件，它都将使用系统默认的配置。

注：View Configurations 对话框提供层的二维色彩设置和其他系统基础的颜色设

置-这些都是系统设置，它们将用于所有的 PCB 文件，并且不是 View Configu-

rations 的一部分。二维工作环境的颜色配置文件也可以创建并保存，并可被以用

在任何时间随时调用，视图配置亦然。

选择 Design>>Board Layers & Colors[快捷键：L]从主菜单中打开 View 

Configurations 对话框。此对话框可让您定义、编辑、加载和保存的视图设置。

它的设定是用以控制哪些层显示、如何显示共同对象，例如覆铜、p，焊盘、线、

字符串等、显示网络名和参考标记、透明层模式和单层模式显示、三维表面透明

度和颜色及三维 PCB 整体显示。

用户可以使用 View Configurations 对话框查看或直接从 PCB 的标准工具栏

的下拉列表中选择它们。图 4.17 示出了视图设置对话框。

图 4.17 视图设置
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如果用户看 PCB 工作区的底部，用户会看到一系列层的标签，用户执行的

大部分编辑动作都在某一层。

    PCB 编译器中有三种层：

Electrical layers-其包括 32 个信号层和 16 个内电层。电气层可以在 Layer 

Stack Manager 对话框中添加或移除，选择 Design>>Layer Stack Manager 来显示

它。

Mechanical layers-它有 16 个决定板的形状、尺寸的普通机械层（general 

purpose mechanical layers），包括制作的细节或任何其他机械设计的细节要求。

这些层可以有选择性地包括在打印输出和 Gerber 的输出中。您可以在 View 

Configurations 对话框中添加、删除和命名机械层。

Special layers-其包括顶部和底部的丝网印刷层、阻焊接层和粘贴层的蒙版层

锡膏层、钻孔层、Keep-Out 层（用来界定电气界限的），多综合层（用于多层

焊盘和过孔） ，连接层、DRC 错误层，栅格层和过孔洞层。

例子的 PCB 是一个简单的设计，可以用单层板或者双层板进行布线。如果

设计较为复杂，用户可以通过 Layer Stack Manager 对话框来添加更多的层。

1、选择 Design>>Layer Stack Manager [快捷键: D， K]，显示层堆栈管理对

话框，如图 4.18 所示。

2、新的层将会添加到当前选定层的下方。层电气属性，如铜的厚度和介电

性能，将被用于信号完整性分析。单击 OK 以关闭该对话框。

图 4.18 层堆栈管理（Layer Stack Manager）

4.7.3 设置新的设计规则

PCB 编辑器是一个以规则为主导的环境，这意味着，在用户改变设计的过

程中，如画线，移动元器件，或者自动布线，Altium Designer 都会监测每个动作，

并检查设计是否仍然完全符合设计规则。如果不符合，则会立即警告，强调出现

错误。在设计之前先设置设计规则可以让用户集中精力设计，因为一旦出现错误

软件就会提示。
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设计规则总共有 10 类，进一步化分为设计规则的类型。设计规则，包括电

气，布线，工艺，放置和信号完整性的要求。

图 4.19 设计规则

现在来设置新的设计规则，指明电源线必须的宽度。具体步骤如下：

1、激活 PCB 文件，选择菜单中的 Design>>Rules。

2、如图 4.19，PCB 规则和约束限制编辑器对话框就会出现。每个规则类显

示在对话框左边 Design Rules 文件夹的下面。双击 Routing 扩展，看到相关的布

线规则。然后双击 Width，显示宽度规则。

3、点击选择每条规则。当用户点击每条规则时，右边的对话框的上方将显

示该规则的范围（用户想要的这条规则的目标），下方将显示规则的限制。这些

规则不仅是预设值，还包括了新的 PCB 文件创建时在 PCB Board Wizard(PCB 板

向导)中设置的信息。

4、点击 Width 规则，显示其范围和约束限制。本规则适用于整个板。
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图 4.20 设置 Width 规则

Altium Designer 的设计规则系统的一个强大的功能是同种类型可以定义多

种规则，每个目标有不同的对象。每个规则目标的确切设置是由被规则的范围决

定义的。规则系统使用一个预定义层次，来确定规则适应对象。

例如，一块板可以先设置一个宽度约束规则，然后地线设定第二个宽度约束

规则，某些连接地的线设定第三宽度约束规则（独立于前两个规则）。规则按照

优先顺序显示。

目前已经有一个宽度约束规则适用于整个板（宽度 = 12mil）。现在将为 12V

和 GND 网络添加一个新的宽度约束规则（宽度 = 25mil）。添加新的宽度约束

规则，步骤如下：

1 、找到 Design Rules 文件夹下的 Width，点击右键选择 New Rule 来添加

一个新的宽度约束规则，只设置 12V 网络。 命名为 width_1 的一项新的规则出

现了。在 Design Rules 文件夹中点击新规则，来修改线宽的范围和约束。

2、在 Name 里键入 12V 或 GND。当单击返回时，名称会在 Design Rules 里

自动更新。

3 、下一步使用 Query Builder 来设置规则的范围，也可以随时在范围内直

接键入。如果用户觉得 Query 比较复杂，可以选择 Advanced 选项，单击 Query 

Helper 按钮来使用 Query Helper 对话框。

4 、点击 Query Builder 按钮，在 Board 对话框中打开 Building Query。
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图 4.21 设置规则的范围

5 、点击 Add first condition，从下拉菜单中选择 Belongs to Net。在 Condition 

Value 中，从列表中点击并选择网络 12V。Query Preview 现在便读到了 InNet

（'12v'）。

6 、点击 Add another condition 来增加定义 GND 的宽度。选择 Belongs to Net

和 GND 作为 Condition Value。

7 、点击 AND，在下拉菜单中选择 OR。检查预览显示 InNet（'12v'）OR InNet

（'GND'）。

8 、单击 OK 来从 Board 对话框中关闭 Building Query。

9 、在 PCB Rules 的底部和 Constraints Editor 对话框中，点击约束值(10mil)

并键入新的值，将 Min Width， Preferred Width 和 Max Width 改变为 25mil。新

规则现在已经被设置，可以选择设置其它规则或者保存并关闭对话框。

图 4.22 新规则设置完成
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10 、最后，点击编辑原来的规则命名宽度（范围设定为所有），并确认

Min Width， Preferred Width 和 Max Width 都设置为了 12mil。单击 OK 关闭该

对话框。

当手工布线或者自动布线时，所有的先将会 12mil 宽，除了 GND 和 12V 是

25mil 宽。

4.7.4 在 PCB 上摆放元器件

    现在我们开始摆放元器件到正确的地方。

1. 按下快捷键 V、D 来进行放大板以及元器件。

2. 摆放排针 Y1，将光标移到 connector 的轮廓的中间，点击并按住鼠标左

键。光标将变更为一个十字准线交叉瞄准线并跳转到附件的参考点。同时

继续按住鼠标按钮，移动鼠标拖动的元器件。

3. 向着板的左手边放置封装（确保整个元器件保持在板的边界内），如图

4.23。

4. 当确定了元器件的位置后，释放鼠标按键让它落进当前区域。值得注意的

是元器件的飞线随着元件被拖动的情况。

5. 以图 4.23 为范例，重新摆放其余元器件。当用户拖动元器件的时候可用

空格键进行必要的旋转（每次向逆时针方向转 90 º），使连接线如图 4.5

所示 。不要忘记，当用户在摆放每一个元器件的时候要重新优化飞线。

图 4.23 元器件放置在板上

元器件文字可以通过相类似的方式重新摆放——点击并拖拉文字，及按下空

格键进行旋转。

Altium Designer 同时包括强大的互动摆放的工具。让我们使用这些以确保

四个电阻器是有较佳的对齐和空间。
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图 4.24 元器件的重新摆放

按住 SHIFT 键，分别单击四个电阻器进行选择，或者点击并拖拉选择框包

围四个电阻器。选择框会显示在每个选定且颜色设置为系统所选择颜色的元器件

周围。要改变这种颜色的设置，选择 Design>>Board Layers & Colors[快捷键：L]。

点击右键并选择 Align>>Align[捷径：A，A] 。在 Align Objects 对话框中，

点击 Space Equally 在 Horizontal 选项并按一下 Top 在 Vertical 选项中。四个电阻

现在对齐并有同样间隔。

在设计窗口中单击其他地方，取消选择所有电阻。

4.7.5 改变封装

现在那些我们放置好的封装里，电容的封装相对于我们的要求太大！让我们

把它的封装改成更小的。

1. 首先，我们将浏览一个新的封装。按一下 Libraries 面板，并从 Libraries

列表中选择 Miscellaneous Devices.IntLib。我们需要有一个较小径向类型

的封装，所以在 Filter 区域内输入 rad。按一下库名称的旁边的...按钮，并

在当前 library 中选择 Footprints 选项来显示封装。按一下该封装的名字以

看见关联的封装。封装 RAD- 0.1 就合适了。

2. 在 Component 对话框中双击该电容器和改变封装为 RAD - 0.1。用户可以

键入新的封装名称，或者按下...按钮，从 Browse Libraries 对话框中选择

一个封装。单击 Ok，新的封装会在板上显示。按照要求重新定位该标识

符。现在用户的板应看起来就像图 4.25 所示。
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图 4.25 元器件使用新的封装放置在板上

    在所有元器件都摆放好后，就需要进行布线的工作了！

可以在 PCB 文件中，使用组合 CTRL 键和箭头键（纵向或横向）或 CTRL、

SHIFT 和箭头键移动选定的物体。选择对象的移动基于 Board Options 对话框

（Design » Board Options[快捷键：D，O）中的当前 Snap Grid 设置。您可以使用

对话框来设定网格预置值。使用快捷键 G 来遍历不同的 snap grid 的设置值。用

户也可以使用 View » Grids 子菜单或 Snap Grid 右键点击菜单来完成。

被选择的对象可以在按住 Ctrl 键的同时按箭头键少量地移动（根据目前的

Snap Grid 值）。被选择的对象也可以在按住 Ctrl 和 Shift 键的同时按箭头键来实

现大幅度的移动（Snap Grid 值的 10 的倍数）。

4.7.6 手动布线

布线是在板上通过走线和过孔以连接组件的过程。Altium Designer 通过提供

先进的交互式式布线工具以及 Situs 拓扑自动布线器来简化这项工作，只需轻触

一个按钮就能对整个板或其中的部分进行最优化走线。

而自动布线提供了一种简单而有力的布板方式，在有的情况下，用户将需要

精确的控制排布的线，或者用户可能想享受一下手动布线的乐趣！在这些情况下

您可以手动为部分或整个板子布线。在这一节的教程中，我们将手动对单面板进

行布线，将所有线都放在板的底部。交互式布线工具可以以一个更直观的方式，

提供最大限度的布线效率和灵活性，包括放置导线时的光标导航、接点的单击走

线、推挤或绕开障碍、自动跟踪已存在连接等等，这些操作都是基于可用的设计

规则进行的。

    我们现在在"ratsnest "连接线的引导下在板子底层放置导线。

在 PCB 上的线是由一系列的直线段组成的。每一次改变方向即是一条新线

段的开始。此外，默认情况下， Altium Designer 会限制走线为纵向、横向或 45 °
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的方向，让您的设计更专业。这种限制可以进行设定，以满足用户的需要，但对

于本教程，我们将使用默认值。

1. 用快捷键 L 以显示 View Configurations 对话框，其中可以使能及显示

Bottom Layer。在 Signal Layers 区域中选择在 Bottom Layer 旁边的 Show

选项。单击 OK，底层标签就显示在设计窗口的底部了。

2. 在菜单中选择 Place>>Interactive Routing [快捷键：P、T]或者点击

Interactive Routing 按键。光标将变为十字准线十字，显示用户是在线放置

模式中。

图 4.26 交互式布线

3. 图 4.26 手动布线检查文档工作区底部的层标签。Top Layer 标签当前应

该是激活的。通过按下*键，来在不退出走线模式的情况下切换到底层。

此键在可用信号层中循环。Bottom Layer 标签会被激活。

4. 将光标定位在排针 Y1 较低的焊盘。点击或按下 ENTER ，以确定线的

第一点起点。

5. 将游标移向电阻 R1 底下的焊盘。注意：线段是如何跟随光标路径来在检

查模式中显示的（图 4.26）。检查的模式表明他们还没被放置。如果用

户沿光标路径拉回，未连接线路也会随之缩回。在这里，用户有两种走

线的选择：

6. CTRL+单击使用 Auto-Complete 功能，并立即完成布线（此技术可以直

接使用在焊盘或连接线上）。起始和终止焊盘必须在相同的层内布线才

有效，同时还要求板上的任何的障碍不会妨碍 Auto-Complete 的工作。对

较大的板，Auto-Complete 路径可能并不总是有效的，这是因为走线路径

是一段接一段地绘制的，而从起始焊盘到终止焊盘的完整绘制有可能根

本无法完成。

7. 使用 ENTER 或点击来接线，用户可以直接对目标 R1 的引脚接线。这种

方法为走线提供了控制，并且能最小化用户操作的数量。

8. 未被放置的线用虚线表示，被放置的线用实线表示。
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9. 使用上述任何一种方法，来在板上的其他元器件之间布线。图 4.26 显示

了一个手工布线的板。

10. 保存设计[快捷键：F，S 或者 Ctrl + S]。

Altium Designer 的交互式布线工具提供了可以用来解决布线时的冲突与障

碍的功能。在交互式布线模式下，通过使用 SHIFT+R 来遍历这些模式。可用的

模式有：

    Push——这种模式将试图移动目标（线和孔），它们可以被重定位来适应新

的布线。

    Walkaround——这种模式将试图找到一个布线路径绕过已经存在的障碍而

不去移动它们。

    Hug＆Push——这种模式结合了Walkaround和Push的功能。它会绕过障碍，

然而也会考虑采用 Push 模式来对待固定的障碍。

    Ignore——这种模式可让用户在任何地方布线。

在交互式布线过程中，如果尝试布线到一个区域，使用 Push or Hug & Push

模式仍然无法完成布线，无法完成布线的提示便会立即出现（图 4.27）。

图 4.27 Push or Hug & Push 模式仍然无法完成布线，会立即出现提示
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4.7.7 关于布线的几点提示

    布线的时候请记住以下几点：

•点击或按下 ENTER，来放置线到当前光标的位置。检查模式代表未被布置

的线，已布置的线将以当前层的颜色显示为实体。

•在任何时候使用 CTRL+单击来执行自动完成连线。起始和终止引脚必须在

同一层上，并且没有不能解决的冲突与障碍。

•利用 Shift + R 来遍历 Push，Walkaround，Hug and Push 以及 Ignore 模式。

图 4.28 双层手动布线

•使用 Shift +SPACEBAR 来选择各种线的角度模式。角度模式包括：任意角

度，45 °，弧度 45 °，90 °和弧度 90 °。按空格键切换角度。

•在任何时间按 END 键来刷新屏幕。

•在任何时间使用 V，F 重新调整屏幕以适应所有的对象。

•在任何时候按 PAGE UP 和 PAGE DOWN 键，以光标位置为核心，来缩放

视图。使用鼠标滚轮向左边和右边平移。按住 CTRL 键，用鼠标滚轮来进行放大

和缩小。

•按 BACKSPACE 键，来取消放置上一条线。

•当用户完成布线并希望开始一个新的布线时，右键单击或按下 ESC 键。

•防止不小心连接了不应该连接在一起的引脚。

Altium Designer 不断的监察板的连通性，并防止用户在连接方面的失误。

•要删除线，单击选择它。它的编辑操作就会出现（其余的线将突出）。按

下 DELETE 键来清除所选的线段。

•重布线是非常简便的——当用户布置完一条线并右击完成时，多余的线段

会被自动清除。

•完成 PCB 上的所有连线后，如图 4.28 所示，右键单击或者按下 ESC 键以

退出防止放置模式。
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4.7.8 PCB 板的自动布线

请完成以下步骤，用户会发现使用 Altium Designer 软件是如此的方便。

1. 首先，选择取消布线，Tools>>Un-Route>>All，[快捷键：U，A] 。

2. 选择 Auto Route>>All。Situs Routing Strategies 对话框弹出。按一下 Route 

All。Messages 显示自动布线的过程。

Situs autorouter 提供的结果可以与一名经验丰富的设计师相比，如图 4.29 所

示，因为它直接在 PCB 的编辑窗口下布线，而不用考虑输入和输出布线文件。

3. 选择 File>>Save [快捷键：F，S]来储存用户设计的板。

注：线的放置由 autorouter 通过两种颜色来呈现：红色，表明该线在顶端的

信号层；蓝色，表明该线在底部的信号层。要用于自动布线的层在 PCB Board 

Wizard 中的 Routing Layers 设计规则中指定。此外，注意电源线和地线要设置的

宽一些。

如果您设计中的布线与图 4.28 所示的不完全一样，也是正确的，因为元器

件摆放位置不完全相同，布线也会不完全相同。

图 4.29 自动布线

因为最初在 PCB Board Wizard 中确定我们的板是双面印刷电路板，用户可

以使用顶层和底层进行手工布线。为此，从菜单中选择 Tools>>Un-Route>>All，

[快捷键：U，A]来取消布线 。和以前一样开始布线，在放置线的时候使用*键

来切换层。 Altium Designer 软件在切换层的时候会自动的插入必要的过孔。
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注意 : 由自动布线器完成的布线将显示两种颜色：红色表示顶部信号层布

线和蓝色表示底层信号层布线。可用于自动布线的信号层定义是符合 PCB Board 

Wizard 中的布线层设计规则约束。还要注意两个电源网络布线更宽的间隔符合

两种线宽规则约束。不必担心，如果在你的布线设计不完全如上图所示的一样。

器件摆放的位置将不会完全一样，也可能是不同的布线样式。

4.7.9 板设计数据校验

Altium Designer 支持多级设计规则约束功能。用户可以对同一个对象类设置

多个规则，每条规则还可以限定约束对象的范围。规则优先级定义服从规则的先

后次序。

为了校正电路板使之符合设计规则的要求，用户可以利用设计规则检查功能

(DRC):

1. 选择 Design»Board Layers & Colors (快捷按键: L) 并确认复选项 Show

及 System Colors 区的 DRC 错误标记选项已被选取，这样 DRC 错误标记

将被显示。

2. 选择 Tools»Design Rule Check (快捷按键: T, D)，打开 Design Rule 

Checker 对话窗口，使能 online 和 batch DRC 选项。

图 4.30 设计规则校验
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3. 规则检测，Online 和 Batch 均可以手工配置.

4. 鼠标点击窗口左边的 Report Options 图标，保留缺省状态下 Report Op-

tions 区域的所有选项，并执行 Run Design Rule Check 命令按钮，随之

将出现设计规则检测报告。并将同时弹出一个消息窗口。

5. 点击违例条款 Silkscreen over Component Pads ，用户将跳转到相应违例

报告区域。

6. 点击违例条款 Silkscreen over Component Pads 的任一条记录，用户将跳

转到 PCB，并放大显示出现违例的设计区域。注意，放大的倍数取决于

在 System - Navigation 环境配置内的设置。

图 4.31 违规细节（1）

7. 显示每项违例的细节, 如上图所示。注意用户可以通过 View Configura-

tions 窗口内的 DRC Detail Markers 配置违例的图形显示颜色。

8. 需要找出所有实际违反丝印与焊盘间安全间距规则约束的对象，可以选择

菜单 Reports→Measure Primitives 命令。注意，用户可以通过快捷功能按

键 CTRL+G 修改电气栅格的值，如 5mil。
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图 4.32 违规细节（2）

运用习惯上与检查晶体管上焊盘间的安全间距相同的技术，检查阻焊数据与

焊盘之间的间隙。
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图 4.33 DRC 报告

一份清晰的 DRC 报告，显示了所有被判定了的违反规则的设计.

现在，用户就完成了 PCB 版图的设计，然后可以开始产生输出数据文档。

4.8 输出文件

现在，您已经完成了 PCB 的设计和布线，用户想要产生输出文件，来审查，

制造和组装 PCB 板。这些文件通常用于提供给板级制造商，因为在 PCB 制造方

面有各种不同技术和方法的存在，Altium Designer 具有产生众多各种用途输出文

件的能力。这些用途包括：

1、装配输出

 装配图 —— 显示电路板每一面上元器件位置和原点信息-代表制板的立

场和方向。

 抓取选择和放置文件 —— 用于元件放置机械手在电路板上摆放元器件-

被智能放置装置用来智能放置元件。

2、文件输出

 .文件产出复合综合图纸 —— -成品板组装，包括元件和线路。
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 .PCB 的三维打印， —— 采用从三维视图观察电路板立体角度的看法。

 .示意原理图打印版画 —— 绘制设计的-原理图示意图图纸中使用的设置。

3、制作输出：

 绘制复合钻孔图综合演示图纸 —— ：在一张图纸中演示板的位置和大小

绘制电路板上钻孔位置和尺寸的复合图纸。

 演示图纸/向导钻孔绘制/导向 —— 在多张图纸上：在不同的图纸中演示

分别绘制钻孔板的位置和大小尺寸。

 最终的绘制图纸： —— 把所有的制作文件合成单个绘制输出。

 Gerber 文件 ： —— 制作 Gerber 格式的制作信息. 

 NC Drill Files ——- 创建能被数控钻孔机使用的制造信息。

 ODB++ ——- 创建 ODB++ 数据库格式的制造信息. 

 Power-Plane Prints ——- 创建内电层和电层分割图纸部多层图纸. 

 Solder/Paste Mask Prints ——- 创建阻焊层和的面具图纸锡膏层图纸。

 Test Point Report ——- 创建在不同模式下设计的测试点的输出结果

4、网表络输出

网络列表表描述在设计上逻辑之间的元器件组件连接，对于移植到其它电子

产品设计中是非常有帮助的。

5、报告输出

 Bill of Materials ——- 为了制作板的需求而创建的一个在不同格式下部

件和零件的清单。

 Component Cross Reference Report ——- 在设计好的原来图的基础上，创

建一个组件的列表。

 Report Project Hierarchy ——- 在该项目上创建一个原文件的清单。

 Report Single Pin Nets ——- 创建一个报告，列出任何只有一个连接的网

络。

 Simple BOM ——- 创建文本和该BOM的CSV （逗号隔开的变量）文件。

大部分的输出文件是用做配置的，在需要的时候设置输出。在您完成更多的

设计后，用户会发现用户经常为每个设计采用相同或相似的输出文件。

Altium Designer 提供一个叫做 Output Job Files 的方式机制，该机制方式使

用一种接口 ——- Output Job Editor，可用于将各种输出文件捆绑在一起，将它

们发送给各种输出方式媒体（直接打印，PDF 和生成文件）。

想得到更多使用 OutputJob Editor 的信息， 请回到 OutputJob Editor 的参考

部分 . 

想得到更多使用 打印 PDF 的信息， 请回到打印 PDF 的参考部分 . 

4.8.1 生成 Gerber 文件

PCB 设计过程的最后阶段，为了更好的满足生产，我们将在指导中说明如

何产生 Gerber 及数控钻孔文件，和 BOM 文件。我们在这里不再使用 Output Job 
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Editor，但是使用单步的菜单命令 - 全部输出文件也可以从菜单命令中直接创建。

记得该配置输出文件是作为项目的一部分存储的。

每一个 Gerber 文件跟板的一个层关联 ——- 器件层、顶部信号层、底部

的信号层、焊料掩蔽层等等。

图 4.34 生成 Gerber 文件

    可取的做法是，在提供用于制造的输出文件之前，先咨询电路板制造商，以

确认他们的要求。

    为教程中的 PCB 创建输出文件：

1. 选择 File>>Fabrication Outputs>>Gerber Files。该设置对话框显示。

2. 单击 Layers tab，然后 Plot Layers 按钮，并选择 Used On。单击 OK 以接

受其他默认设置。

3. 该 Gerber 档案产生后即被 CAM 编辑器打开显示。该 Gerber 文件存储在

Project Outputs 文件夹，这是自动产生的文件夹。每个文件都有反映其层

次的扩展名称，例如：multivibrator.gto 为 Gerber Top Overlay。这些都会

被添加到 Projects 面板的 Generated CAM Document 文件夹中。

类似的，选择 File>>Fabrication Outputs>>NC Drill Files 命令来打开 NC Drill 

Setup 对话框来创建没有连接的通孔数据。

4.8.2 创建一个器件清单

    为教程中的 PCB 创建一个器件清单（BOM）。

1. 选择 Reports>>Bill of Materials，显示 Bill of Materials for PCB Document 对

话框。
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图 4.35 器件清单

2. 使用此对话框，以建立起自己的 BOM 的。在用户想要输出到报告的每一栏

中都启用 Show 选项。

3.从 All Columns 清单选择并拖动栏标题到 Grouped Columns 清单，以便在

BOM 中按该数据类型来分组元件。例如，若要以封装来分组，在 All Columns

中选择 Footprint，并拖曳到分Grouped Columns清单。该报告将据此进行分类。

4. 使能 Open Exported 选项，选择的 CSV 为文件格式，然后点击导出按钮创

建并在您的 CSV 查看器（例如 Microsoft Excel）中立即打开 BOM 的文件。还

有许多可供选择的 BOM 和其他报告的类型，这就提供了高度的灵活性。关闭

对话框。

祝贺！您已经完成了 PCB 设计过程。

4.9 深入研究

本教程只为用户介绍了一些 Altium Designer 的强大功能。我们学会了绘制

电路原理图，设计 PCB 和布线，但我们只学会了 Altium Designer 的一些表面的

功能。当用户深入探索 Altium Designer 的时候，用户会发现它丰富的功能，使

您的设计生活变得更轻松。大量例子均包括在内，并向用户展示了软件的功能。

您可以通过选择 File>>Open 菜单，然后展开 Altium DesigneDesigner 安装路径中

的 Examples 文件夹来打开这些例子。同时，电路板设计的例子也在此文件夹中，

有大量子文件夹的例子用于展示了 Altium Designer 的具体特点。

检查 Circuit Simulation 子文件夹，来探索 Altium Designer 的模拟和数字的

仿真能力。同样，模拟例子电路示例也展示了各种电路的设计，如放大器和电源

供应器，有数模混合电路模式的例子，一个数学函数的例子，还有一个包括线性

和非线性源的例子，还有一个真空管的例子。

随着逻辑转换和设计时钟速度的提高，高质量的数字信号变得越来越重要。

Altium Designer 包括一个先进的信号完整性分析工具，能准确的提供模型并分析

您的电路板布局。信号完整性的要求，如阻抗、过冲、下冲以及斜率被界定为

PCB 设计规则，将在标准设计规则检查中被测试。
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如果有您需要分析得更详细分析的网络，您可以选择 Tools>>Signal Integrity

来进行信号完整性分析仪，在这里您可以进行反射和串扰分离度仿真。结果显示

在像示波器一样的波形分析仪上，在那里您可以研究性能并通过波形结果直接进

行测量。

第五章 附录

1. 附件一：KBP10M.pdf

2. 附件二：58-13011B 電子檔.pdf

3. 附件三：2sk3564.pdf

4. 附件四：uc2845.pdf
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